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What is MLE? What is MyProjects?
As the name implies, the Mobile Learning Environment (MLE) is an educational
environment consisting of students, teachers, mobile devices, and curriculum. The
Mobile Learning Environment is designed to accomplish two educational goals: Engage
the students (have fun), and keep them Organized (stay focused). Students working on
a project in the MLE use MyProjects on their mobile devices to access their project
home page.

MyProjects enables students to organize multiple resources on one simple screen and
encourages students to use a variety of different learning tools— concept maps,
animations, tables, paragraphs, slideshows and web resources—to build complex,
multiform projects.

MyProjects combines GoKnow!’s Sketchy, PiCoMap, GoKWL, and Stopwatch software
with Microsoft’s Word, Excel, Calculator, Reader, and Internet Explorer. Top it all off with
GoSync and GoManage for distributing, viewing, and grading projects, and you have a
powerful learning tool.

System requirements

Windows Mobile 5 device
798 KB available storage memory

Getting started — logging in
To open MyProjects, tap the MyProjects icon on the main Programs list (Figure 1).
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Select your user name from the dropdown box (Figure 2).

Welcome to Goknow! MyProjects 2.0
Plzase log in.

-

Figure 2

If your user name isn’t in the box, you need to create a new one. Tap <New User> and
write your name in (tap on the keyboard icon = at the bottom of the screen to bring up a
keyboard if needed).

Once you have selected a user name, tap “Login.”

If you are using an existing user name and had created a password, enter it in the
password box that appears. If you just created a new user name, you can create a
password at this point or leave the box blank. New users will be prompted to enter their
password twice (or leave it blank twice).

When you have entered your password, tap “Ok.”

Creating a new project
Once you have logged in with your username, you will see a screen that lists the most
recent projects you have worked on (Figure 3). If you have never created a project, you
will see a message that says <No Projects>.

Recent F‘rojets

New Project ||1. Geooraphy
2. Force

Browse... 3. scimeth
4, Characteranalysis
Delete... S. ElernMath

Figure 3
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To create a new project, tap “New” from the list on the left of the screen. A box appears
asking you to name your project. Give your project a name and tap Create. Welcome to
the main MyProjects screen (Figure 4).

* NOTE: Project names as well as resource names must be at least 3 characters long.

ox 12:10 [ok

Figure 4

The blank space is your canvas. The icons at the bottom of the screen are your
resources, or applications. You can use the arrows at the bottom of the screen to scroll
through all of the available resources. Note: If there are no icons at the bottom of the
screen, you will need to re-install the GoKnow applications.

Opening a saved project & deleting a project
If you have already created a project, you can open it when you first log in to MyProjects.
Select the project you wish to open from the list, and tap “Open” at the bottom of the
screen (Figure 4, previous page).

To delete a project, tap “delete” from the list on the left of the screen. A new screen will
appear with a list of available projects. Select the one you wish to delete, then tap
“Delete” at the bottom of the screen (Figure 5).
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You will be prompted to confirm that you want to delete the project. Tap “Yes” to delete
the project. Tap “No” to return to the main Recent Projects screen.

* NOTE: Unless you have backed up your project on GoManage, deleting is
permanent! Be careful what you delete. For more information on using GoManage, see
the GoManage user guide.

Saving a project with a different name (“Save As”)
Open the project you wish to save with a different name. Tap on the “Menu” button at the
bottom of the screen. Tap “File” > “Save As” (Figure 6). You will be prompted to enter a
new name for your project. Type the new name and tap “Save.”

New Project

Open Projeckt
Close Project

Save As...
Exit

Figure 6

Exiting MyProjects

Whenever you are done using MyProjects, tap the utton on the top right corner of
your screen. This will automatically save your project and return you to the main
Program screen on your handheld.

* NOTE: If you are in an application within MyProjects, you will need to tap the “Ok”
button twice.
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Resources

The resource bar at the bottom of the screen in MyProjects features all of the programs
and tools that MyProjects offers. To see all of the resources tap the arrows to scroll left

and right.

The resources are:

PiCoMap

iIKWL

Stopwatch

&

L _J—
®

O

Calculator

Word Mobile

Excel Mobile

Microsoft Reader

Internet Explorer

GoSync

Battery life remaining

& @ =[x

Disk space remaining
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Using resources
To use any of the resources, simply tap on the icon at the bottom of the screen. You will
be prompted to name your resource. Enter a name and tap “Create” (Figure 7).
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Figure 7

* NOTE: If you leave the box next to “Open resource after create” checked, the
resource will open automatically once you tap “Create.” If you uncheck the box, a tile
with the name of the resource will be placed in MyProjects, but the actual resource will
not open until you tap on it from the MyProjects canvas.

Moving to and from project view
The ease of moving to and from the MyProjects canvas is one of the things that makes
MyProjects so powerful. It takes just one tap to work on your resource and one tap to get
back to your canvas: To return to MyProjects after you have finished working on your
resource, simply tap the “Ok” icon in the top right corner of your screen! If you are using
any of GoKnow’s resources, such as Sketchy and PiCoMap, your work will be saved
automatically. If you are using a resource such as Word Mobile, you will be prompted to
save your work before returning to the main MyProjects canvas.

Moving, renaming, and deleting resources on the canvas
Moving a resource
You may move a resource anywhere on the canvas once it has been created. To move
your resource, touch your stylus within the resource’s box, then drag the stylus to the
desired location. The resource will move with your stylus movement. Lift your stylus off
the screen to place the resource.
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If you have a lot of resources in a project, you can move them off the screen and use the
navigation buttons on your handheld device to scroll around the canvas (Figure 8).

f. |MyPrnjects [Demo. &t wx 1:10 ok

Flo

Instructions

|
| ERoughDra
! W FinalEssay,

Mavigation buttons
Figure 8

* NOTE: The location of the navigation buttons may vary depending on the model of
your handheld device. See the information provided by the device manufacturer for more
details.

Renaming your resource

To rename your resource, tap and hold down the text of the resource you wish to edit. A
drop-down menu appears (Figure 9, next page). Tap “Rename.” You will be prompted to
enter a new name for your resource. When you are done, tap “Rename.”
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Figure 9

Deleting a resource

To delete a resource, tap and hold within the resource to bring up the drop-down menu
(Figure 9, above). Tap “Delete”. Tap “Yes” at the warning prompt to delete the resource.
Tap “No” if you don’t want to delete the resource at that time.

* NOTE: Deleting a resource removes it from your canvas, but also deletes the content
in the resource permanently. Be careful what you delete!

Importing a resource
Whenever you create a resource in a project, you will notice an option that says “Import”
next to the “Create” button in the “New Resource” window (Figure 10). This allows you to
import existing resources into your project.

Figure 10

1. In order to import a resource, you must first create the same type of resource as
the one you wish to import. For example, if you wish to import a PiCoMap, you
must first create a PiCoMap in MyProjects, then tap “Import” in the “New
Resource” window. As a reminder: to create a new resource, simply tap on the
icon for that resource from the main MyProjects canvas.

2. When you tap “Import,” you will see a list of all the resources of that type that
have been created. For example, if you created a PiCoMap resource and tapped
“Import,” you would see a list of all of the PiCoMaps currently on the device.
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3. Select the resource you wish to import and tap “Open” (Figure 11).

i) PicoMap

Farmily
AfricaHwy
GeoMap
Method
Methodz

Wy Documentst Goknowppc,

Open Cancel

Figure 11

4. The imported resource will open automatically.

* NOTE: When you import a resource, you are creating a copy of the original resource.
Any changes you make in the imported version will not affect the original version.

Brief overview of each resource

PiCoMap @
PiCoMap is a tool that enables students to create concept maps.

Creating a PiCoMap resource

To create a PiCoMap resource, tap '@from the resource bar. Give the resource a
name, then tap “Create”. You arrive at a new PiCoMap canvas.

There are two main elements that are used when creating concept maps — concepts and
links. A concept is an idea that is contained in a single shape. A link is a line connecting
two concepts. To create a new concept, use the stylus to draw an oval on the PiCoMap
canvas (Figure 12, next page) — it doesn’t have to be a perfect shape! This shape is
often referred to as a “node.”
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When you release your stylus, you will be taken to a “Create Concept” window (Figure

13).
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Figure 13

Enter the name of your concept in the box next to “Name.” You can change the color of

your node by tapping the arrow next to the color in the “Color” box and tapping on the
desired color (Figure 14, next page).
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Figure 14

If you wish to add notes to your concept, you can type in the “Notes” box. This can be
useful if you want to add supporting details. For example, if your main concept was the
name of an important leader, you could include dates of rule, birthday, or other important
information in the notes section. Notes will not show up on the main concept map.
However, the node will be shaded in gray to indicate that there are notes.

When you have finished creating your concept, tap “Ok” to return to the main PiCoMap
canvas.

Your new concept node will appear (Figure 15).

1 o 4x 1:43 [ok

Figure 15
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Repeat this process to create as many nodes as you desire. As shown in Figure 16,
nodes that do not contain additional notes are not shaded in gray (Sub-concept 1 does
not contain notes).

! 5 | PicoMap[*MyMap] & x 1:44 ok

Sub-concept 1

=]
Figure 16

Moving resources and navigating the canvas
To move your concept to a different location on the screen, simply tap inside the shape
and drag your stylus across the screen. Release your stylus at the desired location.

* NOTE: As with the main MyProjects canvas, you can use the navigation buttons on
your handheld to navigate around the canvas — you can expand your PiCoMap beyond
the borders of the original view by using these buttons.

Creating links

Once you have created two or more concepts, you can draw links to connect them. To
draw a link, simply use your stylus to draw a line from the middle of one concept to the
middle of another (Figure 17).

Sub-concept 1

Figure 17
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A “Create Link” box will appear (Figure 18).

Do you mean: Sub-concept 1

Main Concept?

lotes:

Ok Cancel

Figure 18

In the box next to “Name,” you can enter text to describe the relationship between two
concepts, or you can leave it blank. Notice that below the name box, there is text starting
with “Do you mean” (Figure 18, above). This text indicates the directionality of the
relationship.

For example, if you created a link between the words “butterfly” and “caterpillar,” and
added the text “comes before” in the name box, the “Do you mean” section would say
“Do you mean: butterfly comes before caterpillar?” Since you probably meant to say that
a caterpillar comes before a butterfly, you can tap the “Reverse” button to change the
directionality of the relationship.

You can also add notes to a link, just like with a concept. For example, if you link two
people who were married, the notes section would be a good place to add the date of
their wedding.

When you are finished, tap “Ok.” You will return to the main PiCoMap screen. As you
can see, a link is drawn between the concepts with the text you entered and an arrow
indicating directionality (Figure 19). If you entered notes, the text box would be shaded in
gray. If you left the name box blank, you would only see the arrow, no text.

Main Concept

il is related o

Sub-concept 1

Figure 19
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Editing concepts and links

To edit a concept simply tap on the concept to open the “Edit Concept” window (Figure
20). Make your changes, then tap “Ok.”

f.’l Edit Euncef

Mame: |5uh-concept 1 |

Motes:

| Ok | | Canicel |

Figure 20

To edit a link, tap the link to open the “Edit Link” window. As with editing concepts, make
your changes, then tap “Ok.”

Deleting concepts and links

To delete a link, follow the same steps you used to edit a link (tap on the link to bring up
the “Edit Link” window). Then, instead of making changes and tapping “Ok,” simply tap
“Delete” instead (Figure 21).

7 .{l Edit Link

Mame: i related to] |

Do you mean: Sub-concept 1

is related to Main Concept?

Motes:
=
Figure 21
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To delete a concept, simply draw a diagonal line through it on the main PiCoMap canvas
(Figure 22).

e |PicuMap[=*=Myr~1f§fp] & Wx2:12 ok

ain Concept

Sub-tpncept 1

=
Figure 22

A confirmation window will pop up. Tap “Yes” to delete the concept.

* NOTE: If you delete a concept that is linked to another concept, you will also delete
the link. However, if you only delete a link, the concepts will not be deleted.

Adding map notes

You can add notes to your PiCoMap as a whole (in addition to notes added to single
concepts or links). To add map notes, tap “Notes” in the bottom left corner of the screen.
This will bring up the “Map Notes” window (Figure 23).

_}' " IMap Motes

Exit
Yiew Map Motes || &dd Map Notes

Figure 23
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To add notes, tap on the “Add Map Notes” tab at the bottom of the screen. This will open
a new window where you can type your notes (Figure 24).

,i'. | Map Motes

Type your map notes here.l

| Add Motes || Cancel |

Yiew Map Motes | Add Map Notes
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Figure 24

When you are done, tap “Add Notes.” You will return to the “View Map Notes” tab and
your note will be displayed. Repeat the add notes process as desired. Under “View Map
Notes,” you will see a list of all the notes (Figure 25). When you are done, tap “Exit” to
return to the main PiCoMap screen.

Type your map notes here,

ppc | May 9: 3:21 PM-
Here are more notes.

Exit

Yiew Map Motes | Add Map Motes |

Figure 25

As with any resource, when you are finished creating your PiCoMap, tap “Ok” in the top
right corner of the screen to return to the main MyProjects canvas.
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Sketchy &

Sketchy is a drawing and animation tool. Students create animations using freehand and
geometric shapes. Animations can be 999 frames long, and helpful features such as
duplicate frame and insert frame enable efficient and easy animation creation. Teachers
use Sketchy to have students animate processes, relationships and concepts such as
cell development and plant growth.

Creating a Sketchy resource

To create a Sketchy resource, tap & from the resource bar. Give the resource a
name, then tap “Create”. You arrive at a new Sketchy canvas.

Basic Sketchy tools

When you first open Sketchy, you will see a blank canvas with a number of small icons
across the bottom of the screen (Figure 26). These icons are the tools available in
Sketchy. We'll start with the top row of tools and go through them from left to right. More
information about using the tools is in the “Using the tools” section a bit later.

VI B 1 IO E X e

File Edit Frame . [ [}

Figure 26
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1. Drawing tools L=
e [f you tap on the pencil icon, you will see a popup menu with a variety of

drawing tools (Figure 27).

pa7in
o T
O@
o .
Figure 27

e These tools are:
#" Pencil tool for freehand drawing

_ﬁ?' Eraser

£ Select tool (for selecting areas of a picture)
e Straight line tool

- Ribbon drawing tool

Text tool for inputting text

Filled-in square

Filled-in circle

Paint bucket (for filling large areas)
Square outline

Circle outline

~ 00+ 004

Color selector tool

2. Color palette (2" icon from left) L]

e [f you tap on the color palette, you will see a popup menu containing a
number of different colors (Figure 28). You can tap on any of these
colors prior to using another tool to change the color of the
shape/line/text/etc.

Figure 28
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3. Pen size tool
e [f you tap on the pen size tool, you will see a popup menu with several
options (Figure 29). You can tap on one of the lines to change the
thickness of the line drawn using the pencil, straight line, and ribbon tools.
This will also change the size of the eraser and the thickness of the
outlines for squares and circles. Make your selection prior to using
another tool.

Figure 29

4. Play animation m:'
e The green camera icon is how you play an animation once it has been
created. Tap on it once to play the animation — it will turn red. Tap on the
red camera icon to stop the animation.

5. Frame navigation {4 1 P}
e The frame navigation lets you know what frame you are on. When you
create a new frame, the number will increase. You can use the arrows to
go back and forth between frames.

6. New frame tool L]
e If you tap on the new frame tool, you will create a new, blank frame. You
will see that the frame number increases and you will automatically be
taken to the new frame.

7. Duplicate frame tool G
e For making animations, the duplicate frame tool is one of the most
important tools available. If you tap on this duplicate frame icon, you will
duplicate the frame you were on. You will see that the frame number
increases by 1. After duplicating a frame, you could move something on
the 2" frame, duplicate that frame, and continue that process for several
more frames. When you play the animation, you will see movement!

8. Clear screen <
e Thered X icon is how you clear a screen. You must be on the frame you
wish to clear, then tap this icon. Anything that has been drawn in that
frame will be erased. This doesn’t delete the actual frame — it only clears
the contents.

9. Delete entire frame *

e The small recycling bin icon is how you delete an entire frame. Navigate
to the frame you wish to delete, then tap the recycle icon. The frame will
be deleted. If there were frames after the one you deleted, you will be
taken to the next frame of the series. IMPORTANT: you will not be asked
to confirm that you want to delete a frame, so be careful!
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The second row of tools contains even more options! Again, we’ll go through them from

left to right.
1. File
2. Edit
3. Frame

If you tap on the file menu, you will have the option to save your
animation or to exit Sketchy. While Sketchy saves automatically every
time you close, using the save option in the file menu allows you to save
your work whenever you want, without exiting Sketchy. The exit option
takes you back to the main MyProjects canvas. You can also use the “Ok”
button in the top right corner of the screen.

If you tap on the edit menu, you will see the options to undo, cut, copy,
paste, and select all. These tools are useful for copying and moving
things from one frame to another or duplicating things on a single frame.
For example, you could use the select tool to select a shape, then use
copy and paste to paste that same shape in another part of the frame.

Tapping on the frame menu pulls up the options to insert before, insert
after, duplicate, clear, and delete. The insert before and insert after
options allow you to insert a blank frame either before or after the one you
are currently viewing. This is useful if you get to the end of an animation
and realize you need an extra frame in the middle! The duplicate, clear,
and delete options do the same as those icons on the top row of tools.

Cut, copy, and paste '}E El

Just like the options in the edit menu, these icons allow you to cut, copy,
and paste sections of your drawings.

Undo tool *’

If you tap on the undo tool, you will undo the last step of whatever you did
(i.e. the last shape you drew). This tool will only undo ONE step, so if you
make a mistake, you should use the undo tool right away!

Keyboard

If you need to enter text, tap on this icon to bring up the on-screen
keyboard.

Using the tools

To draw, simply select a tool from the Tool menu and draw on the screen! Certain tools
function slightly differently than others, so here is some additional information:

1.

Using the text tool

First, choose the color you want your text to be from the color menu.
Then, select the text tool from the drawing tools.

Tap on the screen to position your cursor.

A popup box will appear with a space for you to enter text.

Type your desired text.

If you want, you can use the drop-down menu under “size” to change the
size of the font.

When you have finished typing, be sure to tap somewhere else on the
screen to make the text permanent.
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* NOTE: You

can only type a limited number of characters in one line. If you would like

to enter more text, simply tap in another position after you finish your first line.

* NOTE: Once you have entered text and tapped somewhere else on the screen, you
can no longer edit the text. If you made a mistake, you can erase what you wrote and

type it again.

2. Using the select tool

rFA
Choose the select tool from the drawing tools menu - 4
Use your stylus to drag a box around the region you want to select. The
easiest way to do this is to tap in the top left corner of where you want the
selection box to begin, then drag to the bottom right corner of where you
want the box to end.
Release the stylus when you have created the box.
To move the selected area, tap in the middle and drag it to a new
location. Rememober, if you don’t like where you moved it, tap “undo”
before you go on to another step!

3. Using the shapes (square or circle)

To create a shape, first select the desired color from the color palette on
the tool bar. Then, select the shape from the drawing tools menu.

Tap and hold your stylus down on the screen, then drag your stylus until
the shape is the size you want.

Remember — you can always undo the shape, or select and move it!

Creating an animation in Sketchy

To create an animation in Sketchy, you must first create multiple frames (like you were
creating a flipbook). On the next page is an example of a simple Sketchy illustrating one
circle orbiting around another (Figure 30, next page). As you can see, the frame number
increases every time the smaller circle is moved. This was accomplished by duplicating
the frame, then selecting the small circle, moving it slightly, duplicating the new frame,
and repeating the process.
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iIKWL @

iIKWL stands for iKnow, iWonder, iLearned. iIKWL is an exercise that guides students
through new material. First, students brainstorm a list of words about their subject; they
then use these words to construct a list of what they know. Next, they ask and document
questions they would like to find out about their subject. After reading and researching
their subject to answer these questions, they record the answers into iKnow portion of
their project. Work is automatically saved, and can be a very helpful resource for quizzes
or tests.
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Creating an iIKWL resource

To create an iIKWL resource, tap @ from the resource bar. Give the resource a
name, then tap “Create”. You arrive at a new iKWL canvas (Figure 31).

f'ilgoxwL[LearninEj o dx 430 ok

W'nrdl List! E
Figure 31

Creating word lists in iIKWL
When you first create an iKWL resource, you will want to create a word list. This list will
be accessible in all three sections (iKnow, iWonder, and iLearned).

1. To create a word list, tap on the “Word List!” button at the bottom right of the
screen.

2. A word list window will appear (Figure 32). Typical question words (who, what,
where, etc.) have already been added to the word list.

f.’ IguKWL[Learn ] &3 dx 4:32 ok

Add Word || || Back

Word List! E
Figure 32
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3. To add a word to the list, tap “Add Word.”
4. In the pop-up box that appears, type your new word and tap “Ok” (Figure 33).

| ok [ Cancel |
Figure 33

5. Your new word will be added to the word list. To add more words, simply repeat
the process.

6. If you want to delete a word, simply tap on the word and tap “Delete Word” at the
bottom of the screen.

7. When you have added all the words you want, tap “Back” from the bottom of the
word list screen. You will return to the main iKWL screen.

iKnow

Students can use the “iKnow” section of iKWL to record things they already know.

1. From the iIKWL screen, tap “iKnow,” then tap “New Fact” at the bottom of the
screen (Figure 34).

|£w Fact || || Balﬂ

word List!

Figure 34
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2. An “Edit” window will appear (Figure 35).

& dx 4:41 ok

what|[when||where|why|[How]
I|Hurse | Bird][Mammal]
Monkey|[Cow | Elephant

3. At the bottom of the “Edit” window, there is a line where you can enter text. You
can tap on any of the words from the word bank at the top of the screen to insert
the word. You can also enter text without using the words from the word bank.

4. When you are finished with your text, tap “Ok.” This will take you back to the
iKnow screen. From here, you can add more statements or tap “Back” to return
to the main iKWL screen.

5. Once you have created an iKnow statement, you can’t edit it. If you make a
mistake, you can delete it and write it again. To delete an iKnow statement, tap
on the statement in the iKnow window, then tap “Delete” at the bottom of the
screen (Figure 36).

Delete Fact

Word List!

Figure
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iWonder

Students can use the “iWonder” section of iIKWL to write down things they want to find
out more about.

1. From the iIKWL screen, tap “iWonder,” then tap “New” at the bottom of the
screen.

2. An “Edit” window appears (Figure 37).

who|[what | when |[Where | Why|[How|
I|Hurse |[Bird |[Mammal]
Monkey||Cow | Elephant

OK | Back |
123(1]2[3]4]5]6[7[8[9]0]-[=]«
Tab[g[w[e[r[t][y[u]iJo[p[[]]
caplafs[d[fla[h]iJk[1];]"]
shift[z[x]c[v][b[n[m][,. [.[7]+
ctifai] -~ [\ INEEE
Word List!

Figure 37

3. To add an item to the iWonder list, follow the same steps as you did for iKnow.

You can enter text on the lines at the bottom of the screen. Again, tapping on any
of the words at the top will add them to the text.

4. When you are finished, tap “Ok” to return to the main iWonder screen. You can
add more questions here, or tap “Back” to go back to the main iKWL screen.

iLearned

Students can use the “iLearned” section of iIKWL to record what they learned at the end
of an activity or after completing some research.

1. From the iIKWL screen, tap “iLearned,” then tap “New” at the bottom of the
screen.
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2. An “Edit” window will appear (figure 38).

Giraffe |[Fish|Horse |[Bird
[Monkey |[Cow|[Elephant

Mammal |

(0] 4 Back
123(1[2[3]4|5]6|7][8][o|0]-[=|*
Tabla|wle[r[t[y[ulifo[p]|I

caPla[s[d[f[a[n]i[k[1[:]"]

Figure 38

3. Just like with the iWonder and iKnow screens, you can enter text by typing or by
tapping on words from the word list.

4. When you are finished, tap “Ok” to return to the main iLearned screen.

5. At the main screen, you can add more items to the iLearned list, or tap “Back” to
return to the main iKWL screen.

6. When you are finished using iKWL, tap the “Ok” button in the top right corner of
the screen to go back to MyProjects.

Stopwatch o
Stopwatch is an application that allows students to time events. It also has a countdown
feature.

Opening Stopwatch
Unlike other resources in MyProjects, Stopwatch does not get added to the main
MyProjects canvas. It can be used as needed, but it doesn’t save anything. If you want
students to use Stopwatch, you need to tell them to open it from the resource bar at the
bottom of the screen.

Even though Stopwatch doesn’t create a resource, it is still opened in the same way as

the other resources. Simply tap o from the resource bar.
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Using Stopwatch
When you open Stopwatch, you will be on the main Stopwatch screen (Figure 39). From
here, you can simply tap “Start” to begin timing.

00:00:00: 000
00hr 00min 00sec 000ms

L =1

Skopwatch | Countdown Timer |

Figure 39

Once you tap “Start,” the numbers at the top of the screen will begin to increase. Tap
“Stop” to pause the timer, then tap “Start” again to restart it. When you are done timing
something, tap “Reset” to zero the timer.

Stopwatch also has a lap feature. While the timer is running, you can tap “Lap” to record
the lap time. Lap time will appear in a list below the timer (Figure 40).

00:00:39:672
00hr 00Omin 39sec 672ms

Lap #10 - 00:00:02:563(00:00;35:514
Lap #9 - 00:00:01:935(00:00:33:249
Lap #8 - 00:00:02:558(00:00:31:314
Lap #7 - 00:00:03:677(00:00:28,756)=
Lap #6 - 00:00:02:035(00:00:25:079
{
{
{

| »

Lap #5 - 00:00:02:360
Lap #4 - 00:00:01:221
Lap #3 - 00:00;01:;131

[ start |
Lap Reset
[ Ston |

0

00:00:23:044 1
00:00: 201654 1
00:00:19:463] ™

Stop

Skopuweatch | Counkdown Ti

Figure 4

* NOTE: As a reminder, you can’t save anything in Stopwatch, so be sure to write down
lap times or other important information before you close Stopwatch!

Copyright 2008, GoKnow! Inc. Last Updated: Page 29
All Rights Reserved 10/2/08



Using the Countdown Timer

Stopwatch also features a countdown timer. After opening Stopwatch from MyProjects,
tap on the Countdown Timer tab at the bottom of the screen (Figure 41).

Countdown Timer

Hrs Min Sec Ms
o []-] [o [~ [o [<]-] [0 [+[+]

00:00:00:000
00hr 00min 00sec 000ms

Stopwatcly || Countdown Timer

Figure 41

On this screen, you can set a countdown timer by using the arrows under Hrs (hours),
Min (minutes), Sec (seconds), and Ms (milliseconds). Set the timer, then tap “Start” to
begin the countdown (Figure 42). The clock will countdown from the time you set until it
reaches 0. To reset the countdown timer, simply tap “Reset.”

|5tupwat & Wx 5:46 ok
Countdown Timer

Hrs Min Sec Ms
[ [ [l o [« e [

01:06:35:926
01hr 06min 35sec 926ms

v|

Stopwatch | Countdown Timer

Figure 42

When you are done using Stopwatch, tap “Ok” in the top right corner of the screen to
return to MyProjects.
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Calculator

Calculator is a basic computation tool. It offers all of the functions of general calculator,
including adding, subtracting, and calculating percentages.

Opening Calculator

Like Stopwatch, Calculator does not get added to the main MyProjects canvas. It can be
used as needed, but it doesn’t save anything. If you want students to use Calculator, you

need to tell them to open it from the resource bar at the bottom of the screen.

To open Calculator, simply tap [:::: on the resource bar.

Using Calculator

When you open Calculator, you will notice that it looks much like any basic calculator

(Figure 43).

5 T
@D®@
49(4)(5)(©) () (e

0 (1)(2)F) (O
@O

Figure 43

To do a simple calculation:
1. Tap the first number

2. Tap:

@ to divide
® to multiply

to subtract

@ to add

3. Tap @ for the result
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Other options in Calculator include:

@ Clear

@ Clear memory

Recall number stored in memory

Store number in memory

When you are done using Calculator, simply tap the E button in the top right corner to
return to MyProjects.

* NOTE: As a reminder, you can’t save anything in Calculator, so be sure to record any
numbers you need before you close Calculator!

Word Mobile W
Word Mobile is a Microsoft application similar to Word, but designed to run on
handhelds. This mobile version of Word is a word processing application that allows you
to type, edit, and work with basic text formatting options.

Creating a Word resource

W

To create a Word resource, tap from the resource bar. Give the resource a name,
then tap “Create”. You arrive at a new Word document.

Basic Word features
When you first open Word, you will arrive at a blank screen (Figure 44).

? dx 1242 ok
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Across the bottom of the screen, you have several basic text formatting options:

B Bold

I jtalic
U  Underline
= Left justify text

Center justify text

Right justify text

i—
—

= Numbered list

Bulleted list

NN
"

Shift list item left

e
"l

Shift list item right

Word options
View
At the bottom left of the Word screen, you will see a “View” button. Tap on “View” to
bring up the View Menu (Figure 45).

v Wrap to Window

Zoom 4

1—
T—

5= 3=

Yiew

Figure 45

You have 3 options in the View menu:
e Toolbar: show or hide the formatting toolbar
e Wrap to Window: wrap the text to the window size, or allow to expand with a
scroll bar for navigation
e Zoom: tap on the arrow to the right to bring up options for zooming in or out

Menu
To the right of the “View” button is a “Menu” button. Tap on “Menu” to bring up a list of
additional options (Figure 46, next page).
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Cut
Copy
Paskte
Edit k
Format #
Tools *
File r
Menu
Figure 46

The options on the Menu list are:

Undo: undo the last action

Redo: redo (immediately after undo)

Cut: cut selected text

Copy: copy selected text

Paste: paste text that was cut or copied

Edit: (Figure 47)
o Find/Replace: find and/or replace specific words in the text
o Clear: clear selected text (must select text first)
o Select All: select everything in document

Find/Replace...

Clear
Select All

Format »

Tools »
File b

. = Menu
Figure 47
e Format: (Figure 48)
o Font: brings up font formatting window where you can change font, color,
size, etc.

o Paragraph:brings up paragraph formatting window where you can
change indentation and alignment options

Figure 48

e Tools: (Figure 49, next page)
o Spelling: checks spelling in document

o Word Count: counts number of words in document

o Insert Date: inserts current date

o Options: brings up options window — DO NOT CHANGE OPTIONS!
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spelling Format

Word Count

Insert Date File k

Options... Menu
Figure 49

e File: DO NOT USE OPTIONS IN FILE MENU WHEN WORKING WITH A WORD
RESOURCE IN MYPROJECTS!

* NOTE: For more information on using Word Mobile, consult software guides provided
by Microsoft.

Excel Mobile

Excel Mobile is a Microsoft application similar to Excel, but designed to run on
handhelds. This mobile version of Excel is a spreadsheet application that allows you to
manipulate numbers, create graphs, and organize data.

Creating an Excel resource
To create an Excel resource, tap from the resource bar. Give the resource a
name, then tap “Create”. You arrive at a new Excel spreadsheet.

Basic Excel features

When you first open Excel, you will arrive at a blank screen (Figure 50).

1 *
2

3

4 =
9

5] |
7

8

9

10

11 -
12 "
A w [+ [1
Ready |Sheetl w |[Sum=0 -

Figure 50
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Similar to other spreadsheet applications, you have rows and columns forming cells

where you can enter information. Simply tap in a cell and begin typing! When you are
done entering information in a cell, tap somewhere else to make the entry permanent.

You can enter a function in a cell by tapping in the cell, then tapping inside the text entry

box at the top of the screen, and tapping the L] button that appears (Figure 51).

[+ ]

-

Py [
RS (S o | [~ o e & | (b=

] DT |

Edit [Sheetl  |[Count=0

Fi‘c"jure.51

-

Tapping the L] button will bring up an “Insert Function” window. In this window, you can
select the category of the function you want as well as the specific function by using the
drop-down menus. When you are done, tap “Ok” (Figure 52).

Cakegory:

Jate atd Tirm

Function:

|DATE|{veaerDnth,dav)

Returns the serial number of a particular
date,

Figure 52

The function will appear in the text input box, with information about the numbers you
need to add to complete the function. For example, if you select “Sum” to find the sum of
specific numbers, you will be prompted to enter those numbers in the function. When

you have entered the numbers, tap in a different cell to finalize the function.

Copyright 2008, GoKnow! Inc.
All Rights Reserved

Last Updated:
10/2/08

Page 36



Excel options

As with Word, Excel has two buttons at the bottom of the screen, “View” and “Menu.”
However, these buttons bring up different menus than the ones found in Word.

View

Tapping on the “View” button brings up a list of options (Figure 53).

200 4

Sheet k

Split

Freeze Panes

Toolbar

v Status Bar
Show 3
Yiew

Figure 53

The options on the “View” list are:

Menu

Full Screen: hides the column and row labels (tap “Restore” next to the text bar
to return to normal view”

Zoom: tap on the arrow to the right to bring up options for zooming in or out
Sheet: tap on the arrow to the right to bring up a list of available sheets in the
workbook, use to navigate to other sheets

Split: splits the view of the screen

Freeze Panes: freezes panes based on the cell you are currently in. If you want
to freeze a specific row or column (so it doesn’t move when you scroll), highlight
that row or column first using the letters/numbers that label the row/column.
Toolbar: show or hide the toolbar (more about the after the menu section)
Status Bar: show or hide the status bar

Show: brings up a list of options for what to show on the screen

Tapping the “Menu” button brings up a list of additional options (Figure 54).

Cuk

Copy
Paskte
Edit k

Insert #
Format »
Tools »
File 3

Menu
Figure 54
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The options on the “Menu” list are:

¢ Undo: undo the last action

¢ Redo: redo (immediately after undo)

e Cut: cut selected cell contents

e Copy: copy selected cell contents

e Paste: paste cell contents that were cut or copied
e Edit: (Figure 55)

o Paste special: after copying cells, tapping this brings up the “Paste
Special” window which allows you to paste specific attributes of the
copied cells (i.e. just the formatting)

o Fill: allows you to fill down or across based on a specific pattern (i.e. days
of the week)

o Clear: clears specific contents of selected cell or cells

= All: clears everything in selected cell(s)
» Formats: clears formatting in selected cell(s)
» Contents: clears contents of selected cell(s), but leaves formatting

o Delete Cells: deletes selected cell(s)

o Find/Replace: find and/or replace specific words or numbers

o Go To:brings up a “Go To” window where you can enter the location of a
specific cell (i.e. E5), and you will be taken to that cell

o Select All: select everything in spreadsheet

Copy
Paste
| Edit )|
Clear L
Delete Cells... Insert b
- Format
Find/Replace... Tools *
Go To... File 3
Select All Menu
Figure 55
e Insert: (Figure 56)

o Cells:brings up an “Insert Cells” window that allows you to shift cells to
make room for inserting new cells

o Chart: see chart section below for more details

o Symbol: brings up a window with various symbols that can be added to a
cell

o Function: brings up the “Insert Function” window (see “Basic Excel
Features, above” for more information on functions)

o Define Name: allows you to define a name for a specific cell or group of
cells

Cells...
Chart... Format
Symbol... Tools
Function... File
Define Mame... e
Figure 56
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Format: (Figure 57)

o Cells:brings up a formatting window that allows you to modify the size of
a cell or cells, the category of the cell (i.e. date, currency, etc.), the font
and alignment of the cell contents, and the border and fill of a cell or cells

o Chart:if you have created a chart, allows you to format the titles of the
chat and the axes, the scale, type of chart (bar, line, pie, etc.), and the
series of information contained in the chart

o Row: hide/unhide a row and auto-fit the row height based on the cell
contents

o Column:hide/unhide a column and auto-fit the column width based on the
cell contents

o Modify Sheets: allows you to rename a sheet, change the order of sheets
contained in a workbook, as well as add and remove sheets

Cells... i
Row
Column * File
Modify Sheets... Menu
Figure 57
e Tools: (Figure 58)

o Sort:brings up a “Sort Cells” window that allows you to sort cells in a
column in either ascending or descending order

o AutoFilter: allows you to set specific filters to limit what cells are displayed

Sort...
AutoFilter File 4

% Menu

Figure 58

e File: DO NOT USE OPTIONS IN FILE MENU WHEN WORKING WITH AN
EXCEL RESOURCE IN MYPROJECTS!

Toolbar

If you select “Toolbar” from the “View” menu, you will see a toolbar displayed above the
View and Menu buttons at the bottom of the screen (Figure 59).
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The options in the toolbar are:

E

Chart (makes a chart based on currently selected cells)

Left justify cell contents

Center justify cell contents

Right justify cell contents

Inserts sum (will prompt you to enter values)

M

Formats cell contents as currency (i.e. 6 becomes $6.00)
* Displays commas and decimal point (i.e. 6000 becomes 6,000.00)

L0 Adds .00 to the end of a numerical value (i.e. 6 becomes 6.00)

Creating charts and graphs in Excel

Excel Mobile can create basic charts and graphs based on data you input. In the
example below, the data are the results of a class survey of favorite color (Figure 60).

f."l Excel Mu_f

| [ Color

Al

A B | © [H
1 |Color MU mber ]
2 |Purple 4
3 |Green 3
4 |Red 7 =
5 |Blue =
6 |Pink 3 ||
7 |vellow 0
8 |Crange 1
)
10
11 -
B ] L |
A w ] [» ]
id| £ = E[=|s » 0|&

) Figure 60

To create a graph based on these data, highlight the desired cells and tap the lid pbutton
on the toolbar at the bottom left. Alternatively, highlight the desired cells and tap “Menu”
- “Insert” > “Chart.”

* NOTE: To highlight multiple cells, tap on one cell, and without lifting the tip of your
stylus, drag your stylus until all the cells are highlighted.
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1. Once you have tapped on the “Chart” button or have selected it from the menu, a
“Chart Type” window will appear (Figure 61).

,}r- I EHEF' Muobile

Choose the Chart Type :
®

O Line

{3 Pie

() o (Scatter)

O frea

Eam;el = N;EHI:
Figure 61

2. Select the type of chart you wish to create by tapping the circle next to the chart
type name.

3. Tap “Next’ at the bottom right of the screen.

4. A “Confirm Data Range” window will appear (Figure 62). Assuming you
highlighted the correct cells at the beginning, you can ignore this window and just
tap “Next” at the bottom right of the screen. (If you think you may have incorrectly
highlighted cells, you can enter the cell information here, but it is easier to go
back and highlight the cells again)

,}r- I EHEF' Muobile

Confirm data range :

[SheetilalEs

Example;
'Sheet1'lA1:410

Bal:.k = N;EHI:
Figure 62
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5. A “Choose Data Layout” window appears (Figure 63). Select the layout that
reflects the way you set up your data. For this example, the data were arranged
in columns. When you have selected the appropriate layout, tap “Next” at the
bottom right of the screen.

_}"’ I Excel Maohile

Choose data layout :
O Dakain rows

|
| I

@ Daka in columns

-

E
Figure 63

6. Another window pops up asking you to indicate how you labeled your data
(Figure 64). In this example, there were labels in both the first row and the first
column, so both boxes remain checked. When you have selected the appropriate
boxes, tap “Next.”

,}"’ I Excel Mobile

Indicate any labels in your selection:

Labels in the First row

Labels in the first column

+
+ =%

=
Figure 64

7. Next, you are asked where you would like the chart to go (Figure 65, next page).
If you select “A new sheet,” Excel will create a new sheet containing your chart. If
you select “An object in the current sheet,” your chart will be inserted into the
sheet containing your data. When you have made your selections, tap finish.
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Figure 65

8. Your chart will appear in the location you specified (Figure 66)!

o wx 539 ok
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Figure 66

If you inserted the chart in a new sheet, use “View” > “Sheet” > “Sheet #” to return to
the sheet where you entered your data. Typically, if you started with a blank Excel sheet,
this would be Sheet 1.

* NOTE: For more information on using Excel Mobile, consult software guides provided
by Microsoft.

"l

Microsoft Reader
Microsoft Reader is a free eBook reader. It will open eBooks that are saved with a .lit

extension.
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Creating a Reader resource

To create a Reader resource, tap r from the resource bar. You will be prompted to
tap “Import Existing.”

* NOTE: You must have downloaded an eBook prior to creating a Reader resource. For
more information on eBooks, see the eBooks guide.

Select the desired eBook from the list, then tap “Open” at the bottom left of the screen.
Your eBook opens automatically.

For more information on using Microsoft Reader, see Microsoft's Reader website:
http://www.microsoft.com/reader/

Internet Explorer g
Internet Explorer on the handheld is similar to Internet Explorer on a computer. It is an
internet browser that allows you to navigate to and view web pages.

* NOTE: You must be connected to the internet to use Internet Explorer. Your handheld
device must have internet capabilities. For information on connecting to the internet, you
may need to talk to your school administrator or IT specialist. Some schools have
specific settings that must be used to access the internet from within the school.

Creating an Internet Explorer resource

To create an Internet Explorer resource, tap .ﬁ from the resource bar. Type a name
for your resource and tap “Create.” An Internet Explorer browser window will open. As
with Internet Explorer on a computer, enter the address of the website in the navigation
bar at the top of the screen and tap the green arrow to the right of the bar (Figure 67).
You will be taken to that web page.

. 7

goknow @

LEARNING

Goknow Learning is the premier provider of
educational software, curriculum, and
professional development For mobile,

handheld computers,

KN

4 | ) ] |. 3
Figure 67

Copyright 2008, GoKnow! Inc. Last Updated: Page 44
All Rights Reserved 10/2/08



Some websites are not optimized for viewing on handheld screens, so they may appear
distorted or the images may not load properly. You may want to test a website on your
own handheld before showing it to students!

* NOTE: You cannot save a particular website in MyProjects. You can only place an
Internet Explorer resource in a project and tell your students the web address you want
them to access. One easy way of providing students with web addresses is to include
them in instructions for the project.

* NOTE: For more information on Internet Explorer, consult guides provided by
Microsoft.

-y
|

GoSync
The GoSync icon within MyProjects allows you to synchronize your handheld to
GoManage without exiting MyProjects. GoManage is a web-based management system
that allows you to do many tasks, such as backing up your work, distributing projects,
viewing student work, and sending feedback. More information about GoSync and
GoManage is available in the GoManage user guide.

Additional Features

Beaming
If you have a handheld with infrared beaming capabilities, you can beam individual

resources to another handheld user.
1. Open the project containing the resource you wish to beam. Have the person
receiving the file open the project into which they wish to receive the file.
2. Tap and hold on the name of the resource you wish to beam to bring up a drop-
down menu (Figure 68).

Rename

Delete

W]

2% || Graph
EThe-'-.I'ovages-DF-Doctnr-DolittIe|
- |Inkernet
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3. Line up your handheld’s infrared port within 6 to 8 inches of another handheld’s
infrared port (Figure 69).

(&

Figure 69

4. Tap “beam.”
5. You will see a “Please Wait” message on your handheld (Figure 70).

Figure 70

6. When the file has finished beaming, you will see a “Resource Sent” message on
your handheld (Figure 71).

Figure 71

7. The handheld receiving the file will display a “File received” message (Figure 72).
Tap Ok.

Figure 72

8. The beamed file will appear in the project open on the receiving handheld!

Additional Support

Additional support and user information can be found at
http://www.goknow.com/Support/.

If you have any questions or concerns, please contact: support@goknow.com.
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